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What's New in Outlook 2007 

The basic concepts of Outlook remain the same in the 2007 release as in earlier 
versions, with a few additions. The biggest improvement in this version is the way that 
the various functions and tools have been linked and organized, making it much easier 
to use all the tools from one place. The biggest change in this version is in the way tools 
and commands are available in the Outlook item windows. Instead of the traditional 
menus and toolbars which are still present in the program window), commands in the 
message, contact, appointment, and other item windows are organized in groups by 
function. The groups are organized on tabs by process, and all the tabs are organized 
on the "Ribbon" that is part of the user interface of several programs in the 2007 
Microsoft Office system. 

The new command structure might take some getting used 
to, but if you use other Office programs you'll find that you 
can come up to speed pretty quickly. 

If you're upgrading to Outlook 2007 from a previous 
version, you're probably more interested in the differences 
between the old and new versions and how they will affect 
you than you are in the basic functionality of Outlook.  The 
following section list new features introduced in Outlook 
2007.  

If You Are Upgrading from Outlook 2003 

If you have been using Outlook 2003, you might not expect to see many improvements 
in Outlook 2007, but you will soon realize that this is not just an incremental upgrade to 
what seemed like a pretty comprehensive set of features and tools. Outlook 2007 
includes a long list of new and improved features, including the following: 

• Redesigned user interface. Compose, format, and act upon information in a 
more accessible, intuitive way. 
 

• To-Do Bar. View your appointments and tasks for the day. 
 

• Instant Search. Search for keywords, dates, or other criteria in your e-mail 
messages, calendar, contact records, or task list. 
 

• Color Categories. Easily personalize and add categories to e-mail, calendar 
items, contacts, or tasks. 
 

• Attachment Preview. Preview your attachments directly in the Reading Pane. 
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Personalizing Your Outlook Workspace 

The Outlook program window includes six areas or elements in which you work with 
Outlook or with your Outlook items (e-mail messages, contact records, calendar entries, 
tasks, or notes). 

 
You might find that this is an ideal arrangement for the way you work. But if you're 
viewing the program window on a low-resolution screen, don't need all the available 
tools, or would like more space for the main work area, you can easily change the 
appearance and layout of the workspace in the following ways: 

• Menu bar. When working in the Outlook program window, you can access 
commands from the menus displayed here. You can't hide the menu bar, but you 
can move it, docking it on any side of the program window or floating it anywhere 
on your screen. 
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• Toolbars. The buttons on the Standard toolbar, which is shown by default, 
represent frequently used commands in the File, Edit, and Actions categories. 
You can also display the Advanced toolbar and the Web toolbar. To display or 
hide a toolbar, right-click anywhere on the menu bar or toolbar area, and then 
click the name of the toolbar. 
 

• Navigation Pane. This view pane appears on the left side of the Outlook 
window. Its contents change depending on the module you're viewing. You can 
tailor the Navigation Pane to suit your preferences: 
 

o You can minimize or expand the Navigation Pane by clicking the left- or 
right-facing chevrons at the top of the pane. 
 

o You can change the width of the Navigation Pane by dragging the vertical 
frame divider to its right. 
 

o You can change the number and size of the module buttons. 

NOTE: To display more buttons at the bottom of the Navigation 
Pane, drag the handle above the module buttons to increase the available 
space, or click the Configure Buttons button in the lower-right corner of the 
Navigation Pane, and then click Show More Buttons. To display buttons in 
a small format or allocate more space to the Navigation Pane folders and 
options, drag the handle to decrease the available space, or click the 
Configure Buttons button and then click Show Fewer Buttons. 

• Reading Pane. When displayed, you can preview a selected message, 
appointment, attached document, and so on in this view pane. You can display 
the pane to the right of or below the content pane, or close it entirely. 
 

• To-Do Bar. On the right side of the Outlook window, this view pane displays a 
monthly calendar, your upcoming appointments, and your task list. You can hide 
or display the pane, change the number of calendar months and appointments 
shown, and arrange the task list in different ways.  

 

Contacts 

Having immediate access to current, accurate contact information for the people you 
need to interact with-by e-mail, telephone, mail, or otherwise is important for timely and 
effective communication. You can easily build and maintain a detailed contact list, or 
address book, in the Microsoft Office Outlook 2007 Contacts feature. From your 
address book, you can look up information, generate messages, and share contact 
information with other people. You can also keep track of your interactions with a 
person whose contact information is stored in Outlook. 
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Working in the Contact Window 

When you create or open a contact record, it opens in a contact window. The contact 
window has its own set of commands separate from those in the Outlook program 
window. You can create, insert, and format information in a contact record by using the 
contact window commands. 

The new Outlook item window interface is designed to more closely reflect the way 
people generally work within the item windows. In a contact window, the interface 
includes the following elements: 

• Commands related to managing contact records (such as creating, saving, 
and printing) are available from the menu that appears when you click the 
Microsoft Office Button. This menu takes the place of the File menu that 
appeared in previous versions of Outlook in the message, appointment, 
contact, and other form windows.  
 

• Some commands are represented by buttons on the Quick Access Toolbar to 
the right of the Microsoft Office Button. By default, the contact window Quick 
Access Toolbar displays the Save, Undo, Redo, Print, Previous Item, and Next 
Item buttons. The Save and Print commands are available on the 
Office menu, but the other commands are not available on either the 
Office menu or the Ribbon; they are available only from the Quick Access 
Toolbar. You can add commands to the Quick Access Toolbar so that they are 
available regardless of which tab is currently active in the message window. 
 

• Below the title bar is the Ribbon, a new feature in many of the programs in the 
Office system. In Outlook 2007, the Ribbon appears in the message, contact, 
appointment, meeting, event, and task windows. (The Outlook program window 
displays a menu bar and toolbars.) Commands are presented on the Ribbon 
rather than on the more-traditional menus or toolbars so that you can work most 
efficiently within the window. The Ribbon is organized into task-specific tabs, 
which are further divided into feature- or task-specific groups of commands. 
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NOTE: The buttons in each group change size depending on the width of the 
program window. They might be large, small, or wide, and might be labeled with 
the button name, icon, or both. Pointing to any button displays the button name in 
a ScreenTip that sometimes also describes the button's function. 

Some buttons have arrows, but not all arrows function the same way. If you point 
to a button that has the arrow incorporated into the button body, clicking the 
button will display a list of options for you to choose from. If the arrow is separate 
from the button body, clicking the arrow will display a list of options and clicking 
the button will perform the currently selected action. 

The goal of the redesigned environment is to make working within an item window more 
intuitive. Commands for tasks you perform often are no longer hidden on menus and in 
dialog boxes, and features that you might not have discovered before are now plainly 
visible. 

 
Saving and Updating Contact Information 

Outlook stores contact information from different sources in separate address lists: 

• Global Address List (GAL). Since UNCW is currently utilizing an Exchange 
server, we have access to a GAL.  The GAL might include names, job titles, e-
mail addresses, office locations, telephone numbers, and other contact 
information. As the GAL is administered as part of the Exchange Server users 
can view the GAL but not change its contents. 
 

• Outlook Address Books. The Contacts address book automatically created by 
Outlook is your main address book. Contacts folders appear in the Navigation 
Pane along with other folders you create, and you can organize them in the same 
manner-for example, at the same level as your Inbox or within a project folder. All 
contacts folders are available from the My Contacts list in the Navigation Pane of 
the Contacts module. 

You can view all your address lists and address 
books in the Contacts area, or you can display a 
simple list from the Address Book window that 
opens when you click the Address Book button 
on the Standard toolbar. In the Address Book 
list, click the name of the Outlook address book 
or address list you want to display. 

 

 
 



INTRO TO OUTLOOK 2007  
 

Intro to Outlook 2007                                                                                                                                                            Technology Enhanced Learning 
Last Modified: 9/07                                                                                                                                  Information Technology Systems Division, UNCW 

7

When you send an e-mail message to a person whose contact information is stored in 
one of your address books, you can quickly address the message to that person by 
typing his or her name into the To, Cc, or Bcc box, or by clicking the adjacent button to 
open the Address Book window and then selecting the intended recipient's name. 

For each person whose information you record in an address book, you can store the 
following types of general information: 

• Name, company name, and job title 
• Business, home, and alternate addresses 
• Business, home, mobile, pager, and other telephone numbers 
• Business, home, and alternate fax numbers 
• Web page address (URL), instant messaging (IM) address, and up to three e-

mail addresses 
• Photo or other identifying image 
• General notes, which can include text and illustrations such as photos, clip art 

images, charts, and shapes 

You can also store personal and organization-specific details for each contact: 

• Professional information, including department, office location, profession, 
manager's name and assistant's name 

• Personal information, including nickname, spouse or partner's name, birthday, 
anniversary, and the title (such as Miss, Mrs., or Ms.) and suffix (such as Jr. or 
Sr.) to use in correspondence 

In order to create a Contact, go to the 
Contacts section of Outlook and click 
New.  You will now be able to enter 
any information you like into the 
following window: 

 

Once you have entered all necessary 
information click Save & Close.
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Creating a Distribution List 

In an address book, you can create a contact record containing a variety of contact 
information for an individual person, or a distribution list containing the e-mail addresses 
of multiple people. You can add people to a distribution list by selecting them from an 
address book or by manually entering e-mail addresses. 

When you send a message to a distribution list, each member of the distribution list 
receives a copy of the message. This is a useful tool if you frequently send messages to 
specific groups of people such as employees working in the marketing department, 
clients located in a particular region, or players on a sports team. 

If you want to send a message to most, but not all, members of a distribution list, you 
can remove people from the recipient list for a specific message at the time you send it. 

In this section, you will learn how to create a distribution list. 

1. In the top left corner of the screen click the down-arrow 
beside the New button and choose Distribution List. 
 

2. Type what you would like to call the Distribution List in the 
Name box.  Then click the Select Members button 
 

3. You can either choose contact information from your 
personal contacts, or use the Global Address List.  
Choose whichever if appropriate from the drop down list in 
the top right corner of the screen. 
 

4. Locate each contact by typing in their name in the Search 
field.  Once located, click Select Members for each 
person. 
 

5. Once you have selected all necessary contacts, click OK, 
and then Save & Close.  You have now created your first 
contact list.  We will cover the usage of such a list later in 
this handout. 
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Sending E-mail Messages 

Although Outlook 2007 includes useful components for managing your calendar, 
contacts, tasks, and notes, the primary reason most people use Outlook is to send and 
receive e-mail messages. Over the past decade, e-mail has become an accepted and 
even required form of business communication. And of course, many people use e-mail 
to keep in touch with friends and family as well. Outlook makes it easy to connect to 
multiple e-mail accounts, either on a business network or over the Internet, and 
provides all the tools you need to send, respond to, organize, filter, sort, find, and 
otherwise manage e-mail messages. 

When sending messages from Outlook, you can: 

• Include attachments such as documents, spreadsheets, or business graphics. 
 

• Personalize your messages by using colors, fonts, backgrounds, and electronic 
signatures. 
 

• Set message options such as voting buttons, importance, sensitivity, and 
reminders. 
  

Addressing Messages 

Addressing an e-mail message is as simple as typing the intended recipient's e-mail 
address into the To box. You may also include more than one e-mail address at a time, 
in order to send the same message to multiple recipients. 

As you type a name or an e-mail address into the To, Cc, or Bcc box, Outlook may 
display matching addresses in a list below the box. Select a name or e-mail address 
from the list and then press Tab or Enter to insert the entire name or address in the box. 

If your e-mail account is part of an Exchange Server network, you can send messages 
to another person on the same network by typing only his or her e-mail alias (for 
example, pinerj) as the @uncw.edu part is not required.  

Sending Courtesy Copies 

To send a courtesy copy of a message to a person, enter his or her e-mail address in 
the Cc box. This is commonly referred to as "CCing" a person. You might CC someone 
to provide him or her with information but indicate that you don't require his or her 
involvement in the conversation. To send a message to a person without making it 
known to other recipients, enter the person's e-mail address in the Bcc box to send a 
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"blind" courtesy copy (also known as "BCCing" a person). Outlook does not display the 
Bcc field by default. To display the Bcc field: 

1. Display a message window. 
2. On the Options tab, in the Fields group, click the Show Bcc button. 

Addresses entered in the Bcc box can't be seen by other message recipients. 
They also aren't included in any replies to the original message. 

Saving Message Drafts 

Until you save or send a message, Outlook maintains a temporary copy of it in your 
Drafts folder. If you close Outlook (or if a problem causes Outlook to close or your 
computer to shut down) before you send the message, the draft retains most or all of 
your work. When the first draft of a message is saved (either automatically or manually), 
a banner appears in the message header with the notation "This message has not been 
sent." 

You can save a message draft at any time by clicking the Save button on the Quick 
Access Toolbar in the message window, or by closing the message window and then 
clicking Yes in the Microsoft Office Outlook message box asking whether to keep the 
draft. (If you click No, Outlook deletes the draft.) To restart work on a draft message, 
display the Mail area, click the Drafts folder in the Navigation Pane, and then double-
click the message you want to open. 

In order to send an e-mail message, do the following: 

1. On the Standard toolbar, click the New Mail Message button. 
 

2. If you know the e-mail address that you would like to send to, 
type it in the To field.  If you do not, then you can access either the GAL or your 
personal contacts by clicking on the To button.  This will open a window similar to 
the one described in the Contacts section of this handout.  You can choose any 
number of addresses or distribution lists from this window. 
 

3. Type a few descriptive words in the Subject line of the message.  The recipient 
will see this before they open the message, so be sure to make it appropriate. 
 

4. You can now type the body of your message in the Message Body section of this 
window.  There is no limit to how many characters you type. 

Once you have typed your message, click Send in the top left corner of the window. 

NOTE: If you would like to attach a file to a message, click the Attach File button.   
The maximum size of all attachments can be no larger than 10 MB. 
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Signatures 

An e-mail signature provides consistent information to message recipients. You can 
include any text or graphics you want in your e-mail signature; you would commonly 
include your name and contact information, but depending on your own situation you 
might also include information such as your company name, job title, a legal disclaimer, 
a corporate or personal slogan, a photo, and so on.  

In order to create a signature, do the following: 

1. On the Tools menu, click Options. 
 

2. Choose the Mail Format tab, and then Signatures. 

 

 

 

 

 

 

 

 

3. On the E-mail Signatures tab, click New. 
 

4. Type a name for your signature.  Click OK. 
 

5. You may now type your signature in the Edit Signature area of the window.  Here 
is an example of an e-mail signature: 

Technology Assistance Center 
Information Technology Systems Division, UNCW 
tac@uncw.edu  

6. Once you complete your signature, you can have it automatically inserted into 
each message you create or reply to.  In order to activate this feature, choose the 
corresponding option in the top right corner of the screen. 
 

7. Once you are done click OK twice.  Your signature is now ready for use. 
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Viewing Messages and Message Attachments 

Each time you start Outlook any new messages received since the last time you 
connected appear in your Inbox. Depending on your settings, Outlook downloads the 
entire message to your computer, which provides basic information about the message, 
such as: 

• The item type (message, meeting request, task assignment, and so on) 
• Who sent it 
• When you received it 
• The subject 
• If you forwarded or replied to it 
• If it contains attachments 
• If it has been digitally signed or encrypted 
• If it has been marked as being of high or low importance 

 

To View Message Attachments 

• You can open the attachment from an open message or from the Reading Pane. 
 

• You can preview certain types of attachments (including Microsoft Office Excel 
spreadsheets, Microsoft Office PowerPoint slideshows, Microsoft Office Word 
documents, and Portable Document Format (PDF) files) directly in the Reading 
Pane without opening the attached file. This new feature of Outlook 2007 saves 
time and increases efficiency. 
 

• You can save the attachment to your hard disk and open it from there. This 
strategy is recommended if you suspect an attachment might contain a virus, 
because you can scan the attachment for viruses before opening it (provided that 
you have a virus scanning program installed). 

To preview the message attachment in the Reading Pane, click the Preview File button 
when viewing the message: 
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Locating Messages 

As you define the criteria for a search, Outlook filters out all messages that don't match, 
making it easy to find exactly what you're looking for. And here's the neat thing: Outlook 
searches not only the content of the e-mail message header and the message itself, but 
also the content of message attachments. So if the search term you're looking for is in a 
Microsoft Office Word document attached to a message, the message will be included 
in the search results. 

To search for an e-mail message, do the following: 

1. Type a keyboard in the Search Inbox field in the top right corner of your screen. 

 

2. As you type, Outlook filters the contents of your Inbox to display only those items 
containing the characters, word, or words you enter, and highlights the search 
term in the displayed messages. 

You can perform this type of search on any of your Mailbox folders simply by first 
clicking on that folder, and then using the Search feature.  If however you do not know 
what folder the message you are looking for is in, you can have Outlook search all 
folders at once.  To do this, do the following: 

1. To the right side of the Search field, click the 
down arrow next to the magnifying glass icon.  
Choose Search All Outlook Items. 

 

2. You can now type in any keyword into the 
Search field and it will now search all your 
Outlook folders including any Archive or 
Personal Folders you may have.  

 

Note: If you want to narrow your search, you can do so by adding more criteria.  To do 
this, click the Double-Down arrows to the right of the Search field.   
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Message Views 

As the number of messages in your Inbox increases, it can be challenging to prioritize 
them. You can customize how you view, arrange, sort, and group messages in Outlook 
to help you quickly determine which are the most important, decide which can be 
deleted, and locate any that need an immediate response. You can view only certain 
groups of messages, such as messages received in the last seven days, unread 
messages, or messages sent to a certain person or distribution list. You can also view a 
timeline of all your received messages. Outlook 2007 offers eight predefined views, and 
you can customize any of these to fit your needs. 

Category views  List views  Other views 
Messages Messages with AutoPreview Message Timeline 
Sent To Last Seven Days   
Outlook Data Files Unread Messages in This Folder   
Documents     

In category views, the Inbox header includes 
only the arrangement and sort order, the 
Reading Pane is visible by default, and the 
message header information is grouped on 
multiple lines. In list views, information appears 
in columns; the Reading Pane is not displayed 
by default, but you can display it if you want. To 
experiment with different views, point to Current 
View on the View menu, and then click the view 
option you want. 

By default, Outlook displays messages in the 
order you receive them, with the newest 
messages at the top of your Inbox. Messages 
received during the current week are grouped by day. Earlier messages are grouped by 
week or by longer periods. You can easily change the order in which messages and 
other items (such as meeting requests and task assignments) appear in the Inbox or 
any other mail folder. You can arrange items by: 

• Attachments. Messages are grouped by whether they have attachments, and 
secondarily by date received. 
 

• Date. Messages are arranged by date of receipt in order from newest to oldest. 
Outlook group’s messages received on each of the past four days, each of the 
previous four weeks, the previous month, and those more than one month old. 
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• E-mail Account. Messages are grouped by the e-mail account to which they 
were sent. This is useful if you receive messages for more than one e-mail 
account in your Inbox (for example, if you receive messages sent to your POP3 
account within your Microsoft Exchange Server mailbox). 
 

• Importance. Messages are grouped by priority: High (indicated by a red 
exclamation point), Normal (the default), or Low (indicated by a blue arrow). 
 

• Recipient (To). Messages are grouped alphabetically by the primary recipients 
(the addresses or names on the To line). The group name exactly reflects the 
order in which addresses appear on the To line. Therefore, a message 
addressed to Tami Mansur; Jarrett Piner will not be grouped with a message 
addressed to Jarrett Piner; Tami Mansur. 
 

• Size. Messages are grouped by the size of the 
message, including any attachment. Groups 
include Huge (1–5 MB), Very Large (500 KB-1 MB), 
Large (100–500 KB), Medium (25–100 KB), Small 
(10–25 KB), and Tiny (less than 10 KB). This 
feature is useful if you work for an organization that 
limits the size of your Inbox, because you can 
easily locate large messages and delete them or 
move them to a personal folder. 
 

• Subject. Messages are arranged alphabetically by 
their subject lines and secondarily by date. This is 
similar to arranging by conversation except that the 
messages aren't threaded. 

 

Organizing Messages in Folders 

After you've read and responded to messages, you might want to keep some for future 
reference. You can certainly choose to retain them all in your Inbox if you want, but as 
the number of messages in your Inbox increases to the hundreds and then into the 
thousands, it might quickly become overwhelming. To keep your Inbox content low and 
avoid an accumulation of unrelated messages, you can organize messages into folders. 

Many people advocate various folder structures as an important part of an 
organizational system. You can apply any of these physical folder structures to Outlook, 
or you can use any other structure that works for you. For example, you might create a 
folder for each project you're working on and store all messages regarding a particular 
project in its own folder. Or you might create a folder to store all messages from a 
particular person, such as your manager, no matter what they are about. 
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You can move messages to folders manually, or you can have Outlook move them for 
you. You can automatically move messages to another folder by creating a rule; for 
example, you can instruct Outlook to automatically move all messages received from 
your manager to a separate folder. You can set up different rules that go into effect 
when you're away from the office. 

In order to create folders, do the following: 

1. On the standard toolbar, click the New arrow, and 
then Folder. 
 

2. Title the folder in the Name box.  Make sure that Mail 
and Post Items is selected, and that you highlight the 
Mailbox- abc1234 item. 
 

3. Click OK, and you have created your folder.  It 
should now appear in your folder list along with the 
rest, and behave exactly as your Inbox. 

Archiving Messages 

As messages accumulate in your Inbox and other message folders, you might need to 
consider other ways to store them in order to cut down on the amount of storage space 
you're using. For example, you might want to archive all messages received or sent 
before a certain date. Archiving messages in a separate Outlook message file helps you 
manage clutter and the size of your primary data file, while still allowing easy access to 
the archived messages from within Outlook. 

NOTE: UNCW Faculty and Staff members are allotted a total of 60MB of total space. 

By default Outlook automatically archives messages in all your folders at regular 
intervals to a location determined by your operating system-usually an Archive data file 
you can access from the Navigation Pane. You can change the default AutoArchive 
settings, such as the archive frequency and location, and you can specify unique 
archive settings for individual folders. 

In order to set up archiving on individual folders, do the following: 

1. Right-Click the folder that you would like to set up Archiving for.  Choose 
Properties.   
 

2. Open the AutoArchive tab. 
 

3. Choose Archive this folder using these settings: 



INTRO TO OUTLOOK 2007  
 

Intro to Outlook 2007                                                                                                                                                            Technology Enhanced Learning 
Last Modified: 9/07                                                                                                                                  Information Technology Systems Division, UNCW 

17

 

4. Choose a time span that you think is 
appropriate for this particular folder.  
Don’t worry – you can always come 
back and change it if necessary. 

 

5. You can either choose to let Outlook 
decide where to place these e-mails, or 
you can decide yourself.  For now lets 
let Outlook choose, so choose Move 
Old items to default archive folder. 

 

6. Click OK.   

 

 

Now that you have archiving set up on this one folder, you will want to do the same for 
every other folder that you want to be periodically “cleaned up”. 

Once you set up archiving on each folder you deem necessary, there is one final step to 
get Archiving turned on.  You must do the following: 

1. Click the File button, and choose Archive. 
 

2. Choose Archive all folders according to 
their AutoArchive settings. 
 

3. Click OK. 
 
 

That’s it!  Your AutoArchive settings are now in 
effect.  Keep in mind however that whatever you 
archive, you will only be able to access from that 
one computer. 
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Calendar 

You might find that your Microsoft Office Outlook Calendar runs your life-but that isn't 
necessarily a bad thing! Using the Calendar effectively can help you to stay organized, 
on task, and on time. You can schedule and track appointments, meetings, and events. 
Because Outlook 2007 maps your scheduled tasks to your calendar, you can look at 
your calendar in Day view or Week view to see the tasks that need to be completed that 
day or that week, and you can track your progress by marking tasks as complete when 
you finish them. 

 

Scheduling and Changing Appointments 

Appointments are blocks of time you schedule for only yourself (as opposed to 
meetings, to which you invite other people). If an appointment recurs at specific 
intervals, such as every Tuesday and Thursday, every other week or every month, you 
can set it up in your Outlook calendar as a recurring appointment; doing so creates 
multiple instances of the appointment in your calendar at the time interval you specify. 
Recurring appointments are linked. When making changes to recurring appointments, 
you can choose to update all occurrences or only an individual occurrence of the 
appointment. 
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When creating an appointment, you can show your time on the calendar as Free, 
Tentative, Busy, or Out Of Office. This information is available to other people on your 
network, and also when you send your schedule information to other people in an e-mail 
message or share your calendar. You can include information such as driving directions 
or Web site links in the Notes field, and attach related files so that they are easily 
available to you at the time of the appointment. 

When Outlook is running, it displays a reminder message 15 minutes before the 
appointment start time-you can change the reminder time or turn it off completely if you 
want to. If you synchronize your Outlook installation with a mobile device such as a 
BlackBerry or a mobile phone running Microsoft Windows Mobile, you can also receive 
reminders on your device. This is very convenient when you are away from your 
computer. 

To schedule an appointment, do the following: 

1. Open the Calendar section of outlook by clicking on the calendar 
icon on the left side of the screen. 
 

2. Click the New button in the top left corner of the screen. 
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3. You can now enter all relevant information for this appointment, including the 
following: 
 

a. Subject 
b. Location 
c. Start and End time(s) 
d. Reminder 
e. Category (sets the color) 

 
4. Once you have entered all relevant information click Save & Close. 

You should now see the following on your calendar: 

 

 

 

 

 

 

 

 

Recurrence 

In addition to creating single-instance appointments, you can also create recurring 
appointments so that you don’t have to recreate the same appointment multiple times.  
To do so, do the following: 

1. Create a new Appointment as described above. 
 

2. Before you save the appointment, click the Recurrence button. 
 

3. You can now choose what days the appointment will occur on, how 
often (once a week, once a month), and when the recurrence should end. 
 

4. Once you are done click Save & Close, and you will now have that appointment 
on your calendar for each day you set up the recurrence. 
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Scheduling, Updating, and Canceling Meetings 

Scheduling meetings through Outlook is significantly simpler than scheduling meetings 
manually, particularly when you are coordinating the schedules of several people. A 
primary difficulty when scheduling a meeting is finding a time that works for everyone. 
To help counter this, Outlook displays the individual and collective schedules of people 
within your own organization. 

You can send a meeting invitation (referred to as a meeting request) to any person who 
has an e-mail account (even to people who don't use Outlook). You can inform non-
critical attendees of the meeting by marking their attendance as Optional. You can invite 
entire groups of people by using an e-mail alias or distribution list. The meeting request 
can include text and Web links, as well as file attachments. This is a convenient way of 
ensuring that meeting attendees have specific information available to them. Outlook 
automatically tracks responses from attendees and those responsible for scheduling the 
resources you requested, so you always have an up-to-date report of how many people 
will be attending your meeting. 

Using the Exchange Server 2007 Smart Scheduling Feature 

Since UNCW is running an Exchange server, Outlook simplifies even further the 
process of selecting a suitable meeting time by presenting you with a list of meeting 
times of any duration you specify, and indicating for each time the number of required 
and optional attendees who are available. 

To use this feature, do the following: 
 

1. Once in the Calendar view, click the New button, and then Meeting Request. 
 

2. Now click the Scheduling button. 
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3. The calendar on the right side of the window indicates the collective availability of 
the group by color.  
 

a. Days when all attendees are available are white 
b. Days when most attendees are available are light blue 
c. Days when most attendees are not available are medium blue 

 
4. Selecting a date in the calendar displays the suggested meeting times for that 

day.  Clicking a meeting in the Suggested Times list updates the meeting 
request. 
 

5. Once you find an appropriate time, click Send.  This will alert all meeting 
attendees to your request, and allow them to either accept or reject your 
invitation. 

 

Working with Multiple Calendars 

It is often useful to have more than one Outlook calendar. The process of creating a 
secondary calendar is the same as that of creating an address book or mail folder-you 
simply create a folder designated to hold calendar items. 

You can display calendars individually, or you can display more than one calendar at a 
time. For instance, you might have separate business and personal calendars and want 
to view them together. 

You can view multiple calendars next to each other, or you can overlay them to display 
a composite view of the separate calendars. When you view and scroll multiple 
calendars, they all display the same date or time period. 

You can drag items from one calendar to another, and copy items between calendars 
by dragging with the right mouse button and then clicking Copy on the context menu. 

In order to view multiple calendars in Overlay mode, do the following: 

1. In the Navigation Pane, in the My Calendars or Other Calendars list, select the 
check box for at least one other calendar. 
 

2. By default, Outlook displays the calendars side by side and in different colors. 
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3. In Side-By-Side mode, the title bar tab of each calendar other than your own 
displays a View In Overlay Mode button. 
 

4. Click this button to view the calendars in Overlay Mode.  This can help when 
scheduling multiple calendars.  
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Public Folders 
 
Public folders are used at UNCW to allow groups and departments to share information, 
such as departmental calendars and generic mail accounts (better known as Mail 
Enabled Public Folders – MEPFs) such at TAC@uncw.edu. 
 

To access Public Folders, click on the Folder List button  in the 
Navigation pane. You will see Public Folders with a plus (+) sign to the left. Click on the 
+ to expand the list of Public Folders. Expand All Public Folders and you should see a 
list of most departments on campus.   
 
Note:  the .UNCW folder contains another folder called ITSD forms. These may be 
useful to you at some point in time.   

 

 

 

 

 

 

 

 

 

 

Questions or Problems?  

Contact the Technology Assistance Center (TAC)  
Location: Hoggard Hall, room 126 
Phone: 962-HELP (4357)  
E-mail: tac@uncw.edu.  
Normal hours of operation: 
Monday – Thursday, 7:30am-11pm; Friday, 7:30am-5:30pm; Sunday, 12pm-11pm 


